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1 Overview

VariTrane™ Duct Designer is a supply duct system design and 
analysis software that will help you efficiently and quickly model 
new or existing round, rectangular, or flat oval supply duct 
systems. You can also create reports that document projected 
performance and a bill of materials. 

VariTrane Duct Designer consists of three applications:

■ Duct Configurator to model and size duct supply systems,

■ Ductulator™ to size system components and determine 
nominal duct size for equal friction applications, and 

■ Fitting Loss Calculator to identify optimal fittings and sizes for 
each duct section by comparing efficiency and cost.

As you enter design information, the program quickly helps 
determine the best shapes, sizes, and fittings for your project in 
order to minimize pressure losses and fan horsepower. You select 
equal-friction or static-regain methodology to size ductwork for 
desired airflow. VariTrane Duct Designer will help you choose the 
duct sizes, shapes, and fittings to optimize your layout.

Design Tools software download

The VariTrane Duct Designer program is part of the Design Tools 
suite. This suite is available for download from the Download 
Center on www.tranecds.com. The software download includes 
these components:

■ Executable files for each Design Tools program

■ Getting Started manuals

■ Installation instructions
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Installing (and uninstalling) VariTrane Duct Designer

The VariTrane Duct Designer program must be installed on your 
hard disk; it cannot run off a network. Step-by-step installation 
instructions are included with the download. 

Note: A license is required to activate the software.

Installing TOPSS
The TOPSS program is also available for download from the 
Download Center on www.tranecds.com. TOPSS must be 
installed on your hard disk. 

After installing the VAV products for the TOPSS program, you will 
be able to make Trane VAV selections while working in VariTrane 
Duct Designer. 

Note: If VariTrane Duct Designer has already been installed, a 
prompt enabling you to quickly install the VAV products only will 
appear during the TOPSS installation process. 

Uninstalling the program
If you ever need to remove the program from your computer, use 
the Uninstall Programs function in the Windows® Control Panel. 
This utility will delete all VariTrane Duct Designer/TOPSS files—
except for those shared by other applications.

Starting VariTrane Duct Designer

Start VariTrane Duct Designer just as you would any other 
Windows program, by doing one of the following:

■ Double-click the VariTrane Duct Designer icon on the 
desktop, or

■ On the Start menu, point to Programs and C.D.S. 

Applications; then click VariTrane Duct Designer.
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Learning to use VariTrane Duct Designer 

The following resources are available to you:

This manual
The Getting Started manual will acquaint you with:

■ How the program works (Chapter 2)

■ Work area basics (Chapter 3)

■ Duct Configurator (Chapter 4)

■ Ductulator (Chapter 5)

■ Fitting Loss Calculator (Chapter 6)

■ Reports (Chapter 7)

Read the manual from cover to cover, or skip directly to Chapter 4 
to begin using the program by completing a tutorial.

Online Help
VariTrane Duct Designer’s online Help describes how to perform 
basic tasks. It also provides detailed information about each 
program entry. To open online Help, do one of the following:

■ On the Help menu, click Contents and Index, or

■ Press F1 for the Help topics related to the currently displayed 
screen, or

■ Click the Help button on the toolbar.

Web resources
Additional sources of information and help are available on the 
Trane Web site. Visit www.tranecds.com for access to our online 
knowledge base, download center, and training opportunities, and 
to subscribe for notifications about program updates.

Technical support
Your license agreement (renewed annually) entitles you to 
continued use of the program, free program upgrades, and the 
latest documentation. As a Trane C.D.S. customer, you’re also 
eligible for free technical assistance from the experienced HVAC 
engineers and software specialists in our support center.
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Support center hours are 8:00 a.m. to 5:30 p.m. (central time), 
Monday through Thursday; and 8:00 a.m. to 5:00 p.m., Friday.

Comments?
We are committed to continually improving our HVAC design 
and analysis tools. As you use VariTrane Duct Designer and 
discover opportunities to improve its usability, or if you encounter 
difficulties, please take a moment to let us know by e-mail, fax, 
or phone.

phone • 608-787-3926

fax • 608-787-3005

Web site • www.tranecds.com

e-mail • cdshelp@trane.com

mailing address • TRANE

Attn.: C.D.S. Group 12-2
3600 Pammel Creek Rd
La Crosse, WI 54601-7599
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2 How VariTrane Duct Designer Works

The VariTrane Duct Designer program contains three different 
applications to accommodate your project needs. Take a look at 
the next few pages to familiarize yourself with each application.

Choosing which application to use

The three different VariTrane Duct Designer applications, as 
described briefly in this section, allow you to experiment to find 
the most efficient solution for your project using either English
(I-P) or metric (SI) units.

Duct Configurator
Use Duct Configurator when you want to model, size, and adjust 
an entire supply-duct system and find the required fan static 
pressure. If you choose, this application can automatically balance 
the system, making your design time instantly more productive. 
Duct Configurator creates files with a *.PRJ extension.

Duct Configurator can …

■ Determine the optimum dimensions for each section

■ Determine design static pressure for an existing or newly 
modeled duct system

■ Add dampers and orifices where needed

■ Balance a system based on either equal-friction or static-regain 
methodology

■ Provide a complete bill of materials

■ Correct airflows for duct-heat pickup and leakage

… and more!
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Ductulator
We converted the popular Ductulator wheel into a user-friendly 
program that helps you to easily and accurately find airflow, 
friction rate, velocity, and diameter for your equal-friction systems. 
You fine-tune the layout based on space requirements and 
installation costs. Ductulator creates files with a *.DCL extension.

Note: Analyze and compare sections with Duct Configurator; size 
duct-system components with Ductulator.

Fitting Loss Calculator 
Fitting Loss Calculator contains a database of ASHRAE and United 
McGill fittings (also used by Duct Configurator). With this 
application, you can quickly find the best fittings and sizes for your 
duct sections. Choose a fitting type and enter dimensions, 
airflows, and other required parameters, and the application 
instantly calculates static-pressure drops through the duct fitting. 
Use Fitting Loss Calculator to compare fittings for performance 
and to find the optimum sections and fittings that balance cost 
and efficiency. Fitting Loss Calculator creates files with an *.FLC 
extension.

Note: You can size equal-friction-based return and exhaust 
systems by using Ductulator in conjunction with Fitting Loss 
Calculator.

To learn more ...
To familiarize yourself with each application, try the tutorials in 
Chapters 4 through 6. If you have a question about a particular 
screen, “worksheet,” or entry, check out the online Help. Press F1 

to display online Help for the current screen; a typical example is 
shown on the next page.
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Duct design methodologies 

Equal friction vs. static regain
In any duct system, static pressure and velocity pressure offset 
friction loss. Duct systems sized with equal-friction methodology 
keep the pressure drop per unit length of duct relatively constant 
throughout the duct system.

By varying sizes, you can create a duct system that delivers the 
required airflow at a velocity that does not increase friction loss. In 
theory, you assume a constant duct friction rate (as determined 
by root section parameters, typically 0.1 in. H2O per 100 feet), and 
calculate duct dimensions as necessary to maintain friction loss 
below the assumed factor.

Equal-friction methodology is widely used for sizing relatively low-
velocity, constant-volume systems, but with VariTrane Duct 
Designer you can apply equal-friction methodology to any system. 

The theory of static-regain design is a little more complex. The 
goal of static regain is to keep static pressure relatively constant 
throughout the duct system. At diverging junctions and 
transitions, velocity pressure decreases to offset friction losses 
while static pressure remains unchanged. The static pressure 
recovered at each section is known as static regain. 
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As distance from the fan increases, this method decreases 
velocity and converts velocity pressure to static pressure at 
approximately the same rate that static pressure is lost to friction. 
Static regain attempts to maintain balanced static pressure at any 
given point in the system, thereby preventing inlet pressures at 
the terminals from varying significantly. Static-regain methodology 
is commonly used with high-velocity, variable-air-volume systems.

VariTrane Duct Designer terminology

Some terminology used in this program may differ from that in 
previous programs. In addition to reviewing the items below, 
remember that you can find in-depth definitions of many terms by 
accessing the program’s Help function. Press F1 or utilize the 
Help drop-down menu.

A section is all ductwork from the inlet of a junction or transition 
fitting to the inlet of the next downstream junction or transition 
fitting. A root section is connected directly to the supply-fan 
outlet.

Junction and transition fittings connect the sections of 
ductwork. In-line fittings join, adjust, or adapt other duct-system 
components within duct sections. VariTrane Duct Designer’s 
database contains hundreds of ASHRAE and United McGill 
fittings. 

Variable-air-volume systems use VAV boxes to modulate flow for 
a zone. Diffusers are the final link in constant-volume duct 
systems that connect the duct system directly to the space.

A variable-air-volume (VAV) system consists of a fan, duct 
sections, and modulating terminal devices (VAV boxes). Ductwork 
and diffusers are downstream from these terminals.

Constant-volume (CV) systems consist of a fan, sections, and a 
diffuser for each terminal device. The diffusers do not modulate 
airflow.

A path consists of the connected sections and fittings between a 
fan and a terminal device. Each section and fitting may belong to 
several paths, but each path is unique.
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The critical path has the largest pressure drop of all the paths 
associated with a fan. Therefore, all noncritical paths are over-
pressurized and require either resizing or the addition of dampers 
and/or orifices to balance the system.

Auto-balance is the capability of VariTrane Duct Designer to 
automatically add dampers or orifices at points of diverging flow, 
as necessary, and to adjust these dampers and orifices to equalize 
the static pressure of noncritical paths with that of the critical 
path.
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3 Work Area Basics

This section discusses:

■ “Layout,” p. 3–1

■ “Menus and toolbar,” p. 3–2

■ “Setting preferences,” p. 3–2

Layout

VariTrane Duct Designer’s main screen is shown below. From this 
screen you can access Duct Configurator, Ductulator, or Fitting 
Loss Calculator.

Figure 3-1 VariTrane Duct Designer work area

*menu bar
*toolbar

application tabs

worksheet tabs

*See online Help to learn more about specific menu commands, toolbar buttons, 
or other elements in the work area
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Menus and toolbar

Menus across the top of the main window organize the 
commands that help you manage and work with your analysis 
projects. A toolbar directly below the menus provides one-click 
access to the most commonly used commands, as well as 
shortcut buttons for the three applications. For more information 
about specific commands, refer to online Help.

Setting preferences

Preferences are options that let you “tell” the program how you 
want it to work. Your choices remain in effect until you change 
them. In VariTrane Duct Designer, the preferences are set under 
the Options menu: 

Auto-Copy Entries
This function affects Duct Configurator Only. If a check mark 
precedes Auto-Copy Entries, the program automatically fills in 
most of the entries for each new element with the values of the 
one just completed. When “on” (default), this command only 
affects three of the Duct Configurator worksheets: Sections, VAV 
Boxes, and Diffusers. 

Note: The Copy button on each of these worksheets performs 
the same function as Auto-Copy Entries, but only for the entries 
on that worksheet.

Choose English I-P or metric SI units of measure

Select which fitting input method to use in Duct 
Configurator

Customize default values in Duct Configurator 
(see “Advanced preferences,” p. 3–3)

Turn on the Auto Copy feature for Duct 
Configurator (see explanation below)

Display/Hide the Toolbar and/or Status Bar
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Advanced preferences
To review and/or change your preferences, open the Options 
menu, highlight Advanced and click Change Preferences.

This screen allows you to change the program defaults for airflow, 
rate of pressure loss, duct sizes, and project location.

Change the default value of the max 
diffuser airflow by typing a new 
value in this field.

Change the default value of the rate 
of pressure loss by checking the 
box and typing a new value in the 
field.

Customize the list of available duct 
sizes by adding and deleting duct 
sizes as needed. Click Set As 

Default to make the new list the 
program default. To return to the 
original settings, click Restore 

Default.

Change the default location for 
project files by typing the new path 
or browsing to the desired location.
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4 Duct Configurator

Duct Configurator is the application you will use to size and 
analyze supply duct sections. You can model the conditions for 
the duct system and specifications for each section, terminal, and 
diffuser. This section-by-section approach incorporates existing 
ductwork and fittings. 

You will need the following information before you can use Duct 
Configurator to detail and refine the design of your supply duct 
system:

■ Airflow and static pressure required at each terminal device 
(typically determined with the help of load-design software)

■ Maximum velocity for each duct section

■ Length of each duct section

■ Block fan airflow, or the system diversity factor, for VAV 
systems

■ Any limitations and constraints on your system design due to
building layout and available space

As you build the project file for your supply duct system, you can 
review and compare design details by switching to the 
spreadsheet view. If necessary, switch back to the other 
appropriate worksheets in order to add, remove, or modify 
sections, VAV boxes, diffusers, or other components of your 
system.

Need to balance the system? Let Duct Configurator do it for you. 
Duct Configurator can automatically resize noncritical paths to 
optimize your system.
4–1CDS-PRM004-EN • VariTrane Duct Designer Getting Started Duct Configurator



Basic duct design procedure

If designing duct systems is new for you, take a moment to 
review this basic procedure. Complete Steps 1 through 4 on your 
own; then Duct Configurator can help you complete your design. 
Still have questions? Refer to the 1993 ASHRAE Handbook—
Fundamentals, Chapter 32, “Duct Design,” or call your local Trane 
sales representative for current literature on duct design.

1 Study the building plans and arrange the supply and return 
outlets to provide proper distribution of air within each space.

2 Select fan outlet sizes that meet the airflow requirements of 
the system.

3 Sketch the duct system, connecting supply outlets and return 
intakes with the air-handling units and/or air conditioners. 
Space that is allocated for supply and return ducts often 
dictates system layout and ductwork shape. Use round ducts 
wherever feasible.

4 Determine the system sections and number each section. A 
duct system should be divided at all points where flow, size, or 
shape changes. 

5 Using design airflows and section descriptions, size supply 
ducts (using either equal-friction or static-regain methodology), 
calculate system total pressure loss, and then select the fan.

6 Adjust diffuser and/or terminal air quantities for design airflow, 
and resize duct sections to account for heat gains or losses 
and leakage.

7 Resize duct sections to approximately balance pressures in 
noncritical sections.

8 Lay out the system in detail. If duct routing and fittings vary 
significantly from the original design, recalculate the pressure 
losses and reselect the fan if necessary.
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A brief overview...

The Duct Configurator window contains six worksheets. 
Complete the Main worksheet to create your project file and 
continue entering information on each tab (working left to right). 
To switch worksheets, click a tab at the bottom of the screen. You 
can switch between worksheets at any time, although you may 
have to enter required data first. Error messages explain what 
information is required. 

Select a design method and specify the conditions of your system 
at the root section to begin your project. Note that when you 
begin defining the sections for your system, the program will 
automatically enter the upstream connection and shape, in 
accordance with the information entered on the Fan worksheet.

Duct Configurator can make sizing adjustments to automatically 
balance noncritical paths, account for leakage, and account for 
thermal loss. Select the check box next to these items to take 
advantage of these optional features. You can select these at any 
time. 

Entering project information for your own purposes is optional, 
and it can be done at any time. 

To open the Project Information dialog box
■ On the Main worksheet for your project, click Project Info.

–or–

■ On the Actions menu, click Enter Project Information.
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If you enter project information, the data will print on the Title 
Page report.

After you have entered all your system design data, your file is 
ready to be calculated. 

To calculate your file
■ On the Main worksheet for your project, click Calculate.

–or–

■ On the Actions menu, click Calculate.

When calculations are complete, you will see the Output 

Reports dialog box, which presents numerous options.

Note: It is best to view or print reports after the file has been 
calculated. This ensures that any design modifications you have 
made will be reflected in the results. Failure to calculate the file 
before viewing or printing a report can yield results based on 
previous calculations or a different file.
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Tutorial

Although Duct Configurator performs a number of functions, this 
exercise focuses on just one: determining duct size and static 
pressure required at the supply fan. 

Scenario
The schematic below illustrates a simple supply duct system. The 
steps that follow describe how to determine the duct size and 
static pressure required at the supply fan, given its size and the 
duct fittings identified below.

Sect 0001
    20 ft.

Sect 0002
    10 ft.

Sect 0003
    10 ft.

Sect 0004
    45 ft.

Sect 0006
    10 ft.

Sect 0005
    27 ft.

Sect 0007
    10 ft.

Sect 0008
     45 ft.

Sect 0009
     27 ft.

Sect 0010
     10 ft.

Sect 0011
     10 ft.

SD5-9 Junction

CD3-15 ElbowSD4-1 Rou nd to round transition

Isolator

SD4-2 Rectangular to round transition

24" x 24 " Fan ou tlet

Sect 0012
     45 ft.

Sect 0013
     37 ft.

Sect 0014
     10 ft.

Sect 0017
     1 ft.

Sect 0019
     1 ft.

Sect 0021
     1 ft.

Sect 0023
     1 ft.

Sect 0015
     45 ft.

Sect 0022
      1 ft.

Sect 0020
      1 ft.

Sect 0016
      1 ft.

Sect 0018
      1 ft.

Sect 001A
      1 ft.

VAV Boxes...
550 CFM,  8 in. inlet diameter
Static pressure drop
0.25 for VAV box
0.43 Downstream

Diversity = 0.85

2

1

4 6 8

3 5 7
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Solution
For this tutorial, we will define the fan characteristics first, then 
each supply air path, beginning with the root section and working 
outward through the terminal section to the VAV box. We will 
start with Section 0001—the section closest to the supply fan.

Note: These steps describe one of several sequences that can be 
used to model this system. You could describe the system and 
supply fan characteristics last rather than first, or describe all of 
the sections before defining any of the VAV boxes. Just 
remember that the Upstream section connection is a required 
entry. The program will not allow you to complete the description 
of a new section, VAV box, or diffuser if you have not defined the 
section that immediately precedes it.

Complete the tutorial by following the steps below.

Open a new file
■ Click the Duct Configurator tab on the main window.

–or–

■ Click the Duct Configurator icon  on the toolbar.

–or–

■ On the File menu, click New and select Duct Configurator 

Project.

Set up the file
■ Check the Options menu to make sure that the units are 

English I-P and Auto-Copy Entries is checked. Under Fitting 

Method, click ASHRAE Selection.

■ For this basic tutorial, you will leave all the default selections 
and values on the Main worksheet as they are. Also, leave the 
three available options in the Optimize Design section 
unchecked.

Define fan characteristics
1 Click the Fan tab at the bottom of the Main worksheet. 

2 In the Diversity factor box, enter 0.85. (Note: The program 
allows the entry of either a diversity factor or a specification for 
block fan airflow. The unused option becomes unavailable.)

3 Leave the default of 2 in. wg in the Static pressure loss... box.

4 In the Fan outlet shape box, select Rectangular.
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5 In both the Fan outlet width and Fan outlet height boxes, 
enter 24 in.

6 On the File menu, click Save As. Name your file and specify a 
location for its storage on your hard disk. Click Save.

Define Section 0001
1 Click the Sections tab, then click New Section. 

2 Leave the Section ID as 0001. In the Description box, type 
Root. (Note: Although section descriptions are optional, you 
may find that routinely entering them in a consistent and 
logical fashion is helpful in the later stages of the project.)

3 In the Upstream fitting connection box, click Select Fitting.

4 In the Fitting type box, select Fan connection.

5 In the Fitting box, select Isolator. Click OK.

6 In the Length box, type 20 ft, as indicated in our sample 
schematic illustration.

Define Section 001A
Next, you will define a section with the ID “001A.” Notice that the 
program automatically applies several values from the previously 
defined section.

1 Click New Section.

2 In the Section ID box, delete “0002” and type 001A.

3 In the Description box, type transition to round.

4 In the Upstream section connection box, select 0001.

5 In the Shape box, select Round.

6 In the Upstream fitting connection box, click Select Fitting.

7 In the Fitting Type box, select Transition. Note that the 
program automatically provides the available rectangular-to-
round fitting. Click OK.

8 In the Length box, type 1 ft.

Define Section 0002
1 Click New Section. The section ID value automatically 

increments to 0002.

2 In the Description box, type Takeoff 1.

3 In the Upstream section connection box, select 001A.
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4 By definition, a section extends from the inlet of its upstream 
junction or transition to the inlet of the next downstream 
junction or transition. In the Upstream fitting connection box, 
click Select Fitting.

5 In the Fitting Type box, select Junction.

6 In the Fitting box, select SD5-9 div., tee with straight 

branch. Click OK.

7 The junction has two discharge openings, so the Section 0002 
connection must also be identified. In the Junction Outlet 
box, select Branch 1.

8 In the Length box, type 10 ft and save your entries.

Define Section 0003
1 Click New Section. The section ID value automatically 

increments to 0003.

2 In the Description box, type Takeoff 1A.

3 In the Upstream fitting connection box, click Select Fitting.

4 In the Fitting Type box, select Junction.

5 In the Fitting box, select SD5-9 div., tee with straight 

branch. Click OK.

6 In the Junction Outlet box, select Branch 1.

7 Check that the Length is 10 ft and save your entries.
4–8 Duct Configurator VariTrane Duct Designer Getting Started • CDS-PRM004-EN



Define Section 0016
1 Click New Section.

2 Change the Section ID to 0016. 

3 In the Description box, type Takeoff 1A Termination.

4 In the Upstream section connection box, select 0003.

5 In the Upstream fitting connection box, click Select Fitting.

6 In the Fitting Type box, select Transition. Note that the 
program automatically provides the available round-to-round 
fitting. Click OK.

7 In the Length box, type 1 ft.

8 In the Material type box, select Flexible, fabric and wire. The 
Roughness box defaults to 0.01 ft. Save your entries.

Define VAV Box 1
At this point, you could define Section 0004 (or even Section 
0005), but we will describe VAV Box 1 instead. 

1 Click the VAV Boxes tab and then click New VAV Box. Duct 
Configurator fills in the default values for several fields.

2 In the Description box, type Takeoff 1A terminal unit.

3 In the Upstream section connection box, select 0016.

4 Change the value in the Cooling design airflow box to 550 

cfm.

5 Change the value in the Inlet diameter box to 8 in. 

6 Change the value in the VAV box SP drop at design airflow 
box to 0.25 in. wg.

7 Change the value in the Downstream SP at design airflow 
box to 0.43 in. wg. The defaults for the other entries are fine 
for this example.

Note: You cannot define VAV Box 2 until you complete Sections 
0004 and 0017.
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Define Section 0004
To define Section 0004, take advantage of the fact that many of 
its characteristics are the same as Section 0003.

1 Click the Sections tab. 

2 In the Section ID box, select section 0003, then click New 

Section. 

3 Change the Section ID to 0004.

4 In the Description box, type Takeoff 1B.

5 In the Upstream section connection box, select 0002. When 
you do, the program automatically identifies the appropriate 
upstream fitting connection, SD5-9 div., tee with straight 
branch, and narrows your choice of Junction outlet to Outlet.

6 In the Length box, type 45 ft.

7 Unlike the other sections defined so far, this one has an elbow. 
To include it in the description of Section 0004, click the Add 

Inline button. 

8 In the Fitting Type box, select Elbow.

9 In the Fitting box, select CD3-15, 90 deg., mitered. Click OK. 
Notice that the elbow now appears under Inline fittings at the 
bottom right of the Sections worksheet. Save your work.

Define Section 0017
Section 0017 is virtually identical to Section 0016.

1 In the Section ID box, select 0016.

2 Click New Section. The Section ID changes to 0017. 

3 In the Description box, type Takeoff 1B Termination.

4 In the Upstream section connection box, select 0004.

5 In the Upstream fitting connection box, click Select Fitting.

6 In the Fitting Type box, select Transition. Note that the 
program automatically provides the available round-to-round 
fitting. Click OK.

7 Verify that the Length is 1 ft; Material type is Flexible, fabric 

and wire; and Roughness is 0.01 ft.

8 Save your entries.
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Define VAV Box 2
1 Click the VAV Boxes tab and click New VAV Box. 

2 In the Description box, type Takeoff 1B VAV box.

3 In the Upstream section connection box, select 0017.

4 The remaining fields are fine as is. Save your entries.

Define the remaining sections
Repeat the process to define the rest of the supply duct system 
paths.

Use the spreadsheet to make changes
Now suppose that, for acoustic reasons, you have determined 
that you must change the Maximum Section Velocity for your 
system from 3000 fpm to 2500 fpm. You can make this change 
from the Spreadsheet view by using the Copy and Paste 
commands, as follows:

1 Click the Spreadsheet tab near the bottom of the Main 
worksheet.

2 Scroll to the right until you reach the Sections column. Double-
click the cell directly below the column heading to display all of 
your Section worksheet entries so far.

3 Scroll to the right until you reach the Maximum Section 

Velocity column, then click the first data field (box) in that 
column. This box turns yellow.

4 Type 2500 in the yellow box and press Enter.

5 From the Edit menu on the toolbar, select Copy.

6 With the cursor still positioned on this box, click the left mouse 
button and hold it down. Drag downward through this column 
to highlight all values on it.

7 From the Edit menu, select Paste. This changes all values in 
the Maximum Section Velocity column to 2500.

8 When you are finished, save your work and then click Previous 
to return to the Main spreadsheet.

Note: Alternatively, you could make this change by clicking 
Advanced on the right side of the Main worksheet, and entering 
the new value in the Maximum Section Velocity override box.
4–11CDS-PRM004-EN • VariTrane Duct Designer Getting Started Duct Configurator



Calculate and view reports
■ On the Main worksheet, click Calculate.

–or–

■ On the Actions menu, click Calculate.

Duct Configurator performs the equal-friction duct-sizing 
calculations. It also creates and stores reports that record the 
design results, the bill of materials for ducts and fittings, and your 
worksheet entries. When finished performing these calculations, 
the application displays an Output Reports dialog box. Check 
Project Summary and click Preview.

Note: You can view or print all the other available reports and bills 
of material for your system by checking the desired options in the 
Output Reports dialogue box and selecting Preview or Print. 

The Fan Information section of the report reveals that the system 
supply fan must provide a block airflow of 3740 cfm and generate 
2.91 in. wg. of static pressure.

Refer to Chapter 7 for examples of each report.
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Advanced tutorial

This exercise provides the opportunity for you to explore and 
practice using some of the more advanced features of the 
program.

Note: For this advanced tutorial, leave all default values as they 
are unless instructed otherwise. 

Complete the tutorial by following the steps below.

Open a new file
■ Click the Duct Configurator tab on the main window.

–or–

■ Click the Duct Configurator icon  on the toolbar.

–or–

■ On the File menu, click New and select Duct Configurator 

Project.
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Set up the file
■ Check the Options menu to make sure that the units are 

English I-P and Auto-Copy Entries is checked. Under Fitting 

Method, click ASHRAE Selection.

Define the friction rate and enable auto-balancing
For the design of this system, which has a large supply opening, 
you will enter a specific value for the friction rate, instead of 
allowing the program to calculate this value automatically. 

1 On the Main worksheet, change Use calculated friction rate? 
to No.

2 In the Friction rate per 100 ft box, enter 0.13.

3 Under Optimize Design, select the Auto balance system 
check box. This will automatically apply dampers or orifices 
where they are necessary to balance pressure drop for 
noncritical paths with that of the critical path.

Define fan characteristics
1 Click the Fan tab at the bottom of the Main worksheet.

2 In the Diversity factor box, enter 0.85.

3 In the Fan outlet shape box, select Rectangular.

4 In the Fan outlet width box, enter 35 in.

5 In the Fan outlet height box, enter 18 in.

6 On the File menu, select Save As. Name your file and specify 
a location for it on your hard disk. Click Save.

Define Section 0001
1 Click the Sections tab, then click New Section. (Leave the 

Section ID as 0001.)

2 In the Description box, type root through curb. 

3 In the Upstream fitting connection box, click Select Fitting.

4 In the Fitting box, select SR7-5 SWSI with elbow down.

5 In the Variables section of this same dialog box, enter 36 in. for 
length (defining the distance between the fan and the down 
elbow). Leave Blast/Inlet set to the default value of 0.8. Click 
OK to return to your current Sections worksheet. 

6 In the Length box, enter 10 ft.

7 Click Add Inline.
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8 In the Fitting type box, select Elbow.

9 In the Fitting box, select CR3-13 mitered, single thickness 

vanes. Click OK.

Define the plenum section
1 Click New Section. (Leave the Section ID as 0002.)

2 In the Description box, type plenum. 

3 On the Options menu, point to Fitting Method and click 
Lowest Friction. In order to increase input speed, you have 
just enabled the program to automatically select the fitting with 
the lowest loss—within the fitting category you specify—for 
each section.
(Note: You can change fitting input methodology at any time 
during your input process. To select a fitting other than the one 
the current program methodology selects, simply return to the 
Options menu, change the Fitting Method, and assign the 
fitting you require.)

4 In the Upstream section connection box, select section 0001.

5 Check the Plenum box (in the right column). 

6 In the Upstream fitting connection box, select Exit. The 
program automatically enters SR2-1 abrupt exit.

Define Section 0003
1 Click New Section. (Leave the Section ID as 0003.)

2 In the Description box, type rectangular entry from plenum.

3 In the Upstream section connection box, select section 
0002.

4 In the Upstream fitting connection box, select Entry 

(because this connection re-enters the ductwork from the 
plenum). Because you have enabled the Lowest Friction fitting 
input methodology, the program automatically provides the 
fitting SR1-1 conical bellmouth from plenum.

5 In the Length box, enter 45 ft.

6 Click Add Inline.

7 In Fitting type box, select Elbow.

8 In the Fitting box, select CR3-1 smooth radius without 

vanes.

9 Click OK to return to the Sections worksheet.
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Define Section 0004
1 Click New Section. (Leave the Section ID as 0004.)

2 In the Description box, type round entry from plenum.

3 In the Upstream section connection box, select section 
0002.

4 In the Shape box, select Round.

5 In the Upstream fitting connection box, select Entry 
(because this connection also re-enters the ductwork from the 
plenum). The program automatically provides the fitting ED1-2 

bellmouth.

6 In the Length box, enter 10 ft.

Define Section 0005
1 Click New Section. (Leave the Section ID as 0005.)

2 In the Description box, enter an appropriate description.

3 In the Upstream section connection box, select section 
0004.

4 In the Upstream fitting connection box, select 90 degree 

tee. The program automatically provides the fitting SD5-12 

div., tee w/45 deg. entry branch.

5 In the Junction outlet box, select Branch 1.

6 Leave other default values as they are, and leave the Length

at 10 ft.

Define sections 0006 through 0009
Use the skills you have acquired to define sections 0006 through 
0009.

Define section 0010
1 Click New Section. (Leave the Section ID as 0010.)

2 In the Description box, type Takeoff termination.

3 In the Upstream section connection box, select section 
0008.

4 In the Upstream fitting connection box, select Transition. 
The program automatically provides the fitting SD4-1 round to 

round.
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5 In the Length box, enter 1 ft.

Define sections 0011 through 0014
Remember to save your work frequently.

Define the first VAV box for this system
1 Click the VAV Boxes tab at the bottom of the current 

worksheet.

2 Click New VAV Box.

3 In the Description box, type takeoff section 0010.

4 In the Upstream section connection box, select section 
0010.

5 Click Trane. A new set of options appears.

6 In the Model box, select Single duct with VCWF. You will see 
that several input fields become red, and others become 
white. All red fields are required. (Note: You can access 
extensive information on Trane VAV box selections at any time, 
including terminology used, limits for the various fields, 
dynamic links between the input fields, and explanations of 
error messages. Simply press the F1 key or use the Help drop-
down menu.)

7 In the Control type box, select UC400DDC-Basic (water heat 

- Modulating).

8 In the Cooling design box, type 600 cfm.

9 In the Cooling minimum box, type 180 cfm. Notice that, 
when you move to the next entry, the program automatically 
sets Valve heating to 180 cfm also.

10 In the Flow rate box (in the Fluid section), type 4 gpm.

11 In the Insulation box (bottom of the right column), select ½” 

foil faced.

Define the remaining VAV boxes
Because all information other than the upstream connection is the 
same for VAV boxes 002 through 0005, you can quickly define the 
remaining VAV boxes. For each, click Copy and then assign the 
proper Upstream section connection. The program 
automatically completes the other required fields.

Calculate and view reports
Click Calculate, and then Yes when asked whether you wish to 
save your file before the program performs calculations. The 
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program quickly performs duct-sizing calculations for all sections, 
records all your worksheet entries, and creates several reports. 
These reports include useful summaries of your system design, 
as well as bills of material for both ducts and fittings.

To view the Project Summary report:

1 When calculations are complete, click OK in the dialog box 
identifying the number of fittings that have been added. 

2 In the Output Reports dialog box, check Project Summary and 
select Preview (to view the report on your screen), or Print.

The Project Summary Report for this system indicates that the fan 
must supply a block fan airflow of 2550 cfm and static pressure of 
2.89 in. wg.

Note: Because the Auto balance feature was enabled, the duct 
system has been completely balanced with dampers as shown 
above.
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5 Ductulator

Ductulator™ simplifies the manual process of sizing ductwork 
based on equal-friction methodology. It computes the friction rate 
or pressure drop in a particular duct so that you can specify an 
appropriate nominal size. Or given a nominal size, it can compute 
pressure loss in a duct.

A brief overview...

To get started, describe the physical characteristics of the duct 
and specify two performance parameters (typically airflow and 
maximum velocity), and the program will calculate the friction rate 
and dimensions. With that information, you can enter a nominal 
duct size that approximates the calculated value(s) and let the 
program determine the new friction rate and maximum velocity. 
Ductulator lets you analyze friction losses through supply, 
exhaust, or return duct fittings.

Required entries
Ductulator requires the following information:

Note: To use a different variable, delete one of your entries and 
enter a new value. The program will calculate the other two.

Required entries Plus any two of these variables …

Duct Shape Airflow

Material Type Friction Rate

Roughness Velocity

Duct ID Dimension(s)

Length
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For a round duct, enter the Diameter plus Airflow or Friction 

Rate or Velocity.

For a rectangular or oval duct, either:

■ Enter the Height and Width plus Airflow or Friction Rate or 
Velocity. These entries can be made in any order.

–or–

■ Enter one dimension (either Height or Width) plus two other 
variables from among Airflow, Friction Rate, and Velocity. 
This method fixes the duct height or width if you enter that 
value before completing the other entries.

Equation methodology

Equivalent-by-flow equation
The following “equivalent diameter” equations are based on equal 
airflow, resistance, and length.

where …

■ De=diameter equivalent by flow, in inches (in.) or millimeters 
(mm)

■ h=height of rectangular duct, in inches (in.) or millimeters (mm)

■ w=width of rectangular duct, in inches (in.) or millimeters (mm)

■ a=major axis of flat oval duct, in inches (in.) or millimeters (mm)

■ b=minor axis of flat oval duct, in inches (in.) or millimeters 
(mm)

Rectangular ducts … Flat oval ducts …

De
1.3 h w )0.625¥(

h w+( )0.25
-------------------------------------------------= De

1.55 πb2

4
----------- b a b–( )+

0.625

πb 2 a( b )–+( )0.25
--------------------------------------------------------------------------------=
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Equivalent-by-friction equation
The following “equivalent diameter” equations are based on an 
equal pressure loss per unit of length:

where …

■ Dh=diameter equivalent by friction, in inches (in.) or millimeters 
(mm)

Equivalent-by-velocity equation
The following “equivalent diameter” equations are based on an 
equal cross-sectional area:

where …

■ Dv=diameter equivalent by velocity, in inches (in.) or 
millimeters (mm)

Rectangular ducts … Flat oval ducts …

Rectangular ducts … Flat oval ducts …

Dh
2 h( w )¥

h w+
----------------------------= Dh

4 πb2

4
----------- b a b–( )+

πb 2 a b )–(+
--------------------------------------------------------=

Dv 2 h w¥
π-----------------

= 
 0.5

Dv 2

πb2

4
----------- b a( b )–+

π----------------------------------------------







=







0.5
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Air density equation
The program solves these equations to determine air density:

where …

■ BP=barometric pressure, in inches water gauge (in. H2O) or 
kilo Pascals (kPa)

■ z=elevation, in feet (ft) or meters (m)

■ DB=dry bulb temperature, in degrees Fahrenheit (°F) or 
degrees Centigrade (°C)

■ ρ=density, in pounds mass per cubic foot (lbm/ft3) or kilograms 
per cubic meter (kg/m3)

I-P …        SI …

BP 407.19 1 6.875 10 6–¥(–( )¥ z )5.26¥=

ρ BP
10.266 DB( 460 )+
------------------------------------------------------------=

BP 101.325 1 2.2557 10 5–¥(–( )¥ z )5¥=

ρ BP
0.287 DB( 273 )+
--------------------------------------------------------=
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Tutorial

The following tutorial demonstrates a common application for 
Ductulator: identifying appropriate nominal duct sizes based on 
the equal-friction duct-sizing methodology. 

Scenario
The schematic below illustrates a simple duct system that must 
be sized to handle 1075 cfm. Determine the friction rate of the 
root section based on a maximum velocity of 1200 fpm. Then 
determine the proper nominal size for the remaining duct 
sections, using the root-section friction rate as the target.

Solution
Start VariTrane Duct Designer and initiate your new project by 
doing one of the following:

Open a new file
■ Click the Ductulator tab on the main window.

–or–

■ Click the Ductulator icon  on the toolbar.

–or–

■ On the File menu, click New and select Ductulator File.
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To find the target friction rate for the system, begin with the root 
section.

1 Select Rectangular for the Duct Shape.

2 In the Duct ID box, enter 41b. 

3 Complete these required entries: 

When finished, your screen should look like this:

4 Click Calculate. When you do, Ductulator automatically 
calculates the performance characteristics of the root section 
and displays the results in a spreadsheet format. The report 
contains more columns than the screen can display at one 
time, so use the horizontal scroll bar to bring the other 
performance information into view. Click Close to return to the 
main Ductulator window. 

Required entries Select or type:

Material Type Galv. steel, long. seams

Roughness  0.0003

Length 15 ft

Airflow 1075 cfm

Velocity 1200 ft/min
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5 With 41b still displayed as the Duct ID, delete the Velocity 
value. Then change the Height and Width entries to nominal 
sizes that approximate the values calculated by the program. In 
this case, use 12 for both dimensions.

6 Click Calculate and locate the resulting friction rate in the 
Ductulator report. The displayed value, 0.125 in. H2O/100 ft, is 
the target friction rate for sizing the other duct sections. Click 
Close to exit the report.

Size Section 43c
1 Click New Duct at the bottom of the screen. Notice that the 

characteristics of the previous section become the default 
values for this one.

2 In the Duct ID box, enter 43c.

3 In the Length box, enter 6 ft.

4 In the Airflow box, enter 300 cfm. 

5 In the Friction rate box, enter 0.125.

Size the remaining sections
1 Click New Duct.

2 Refer to the schematic to complete the entries for each duct 
section. 

Note: If the Auto Copy Duct option is on, the application 
automatically copies the friction rate from the previous section. 
You need only enter values for Duct ID, Length, and Airflow.
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Calculate
1 Click Calculate to display the performance and dimensions 

computed for each duct section. Notice that none of the 
section dimensions (except for those of the root section) are a 
nominal duct size. Click Close.

2 Beginning with section 43c, delete the value in the Friction 

rate box, and change the Height and Width values calculated 
by the program to nominal sizes. 

3 Do the same for the remaining sections. 

4 Click Calculate at any time to display the effects of your 
changes. 

5 Click Save to name and store your project.

Each section of this simple duct system is now properly sized 
based on the equal-friction method.

Refer to Chapter 7 for an example of the Ductulator report.
5–8 Ductulator VariTrane Duct Designer Getting Started • CDS-PRM004-EN



6 Fitting Loss Calculator

Fitting Loss Calculator computes the total pressure drop of a 
fitting based on its configuration, dimensions, and the airflow 
passing through it. The application bases its calculations on an 
extensive library of fittings originating from United McGill and 
ASHRAE’s 1993 duct fitting database. 

Fitting Loss Calculator computes total pressure performance for 
supply, exhaust, or return duct fittings. VariTrane Duct Designer 
gives you two ways to use Fitting Loss Calculator:

■ Within Duct Configurator, to add and size inline fittings using 
the Sections worksheet.

■ By itself, to compare fitting efficiencies.

The only difference between these operating modes is the 
number of entries needed: Duct Configurator automatically 
passes relevant information about the duct section to Fitting Loss 
Calculator. 

A brief overview...

Describe the fitting(s) and applicable air conditions, and the 
application calculates:

■ Velocity at the inlet(s) and/or outlet(s)

■ Velocity pressure at the inlet(s) and/or outlet(s)

■ Total pressure drop at the inlet(s) and/or outlet(s)

■ Loss coefficient at the inlet(s) and/or outlet(s)
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Tutorial

The following exercise demonstrates how you can compare the 
total pressure performance of various duct fittings to optimally 
balance the efficiency and cost of your duct system designs.

Scenario
One section of a noncritical supply duct path presently calls for an 
SD5-12 junction. At this point in the design process, 6000 cfm of 
air enters the junction, 2500 cfm of air leaves the junction through 
the branch, and 3500 cfm of air leaves through the outlet. The 
relevant diameters are: 

■ 18 inches for the common inlet, 

■ 16 inches for the system outlet, and

■ 12 inches for the branch.

Compare the performance of junction SD5-12 with that of the less 
expensive SD5-9.

Airflow Airflow

SD5-12 SD5-9

6000 
cfm

6000
cfm

Branch

2500 cfmBranch

2500 cfm

3500 
cfm

3500 
cfm
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Solution
To compare the performance of junction SD5-12 to SD5-9, 
complete the following steps.

Open a new file
■ Click the Fitting Loss Calculator tab on the main window.

–or–

■ Click the Fitting Loss Calculator icon  on the toolbar.

–or–

■ On the File menu, click New and select Fitting Loss 

Calculator File.

Define SD5-12
1 In the Inlet Shape section, click Round.

2 In the Fitting type box, select Junction.

3 In the Fitting box, select SD5-12.

4 Refer to the scenario and enter the appropriate diameter and 
airflow values. When finished, your screen should look like 
this:

Define SD5-9
1 Click New Fitting at the bottom of the screen.

2 In the Fitting box, select SD5-9.
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3 Refer to the scenario and enter the appropriate diameter and 
airflow values.

Calculate and compare
1 Click Calculate. When you do, the Fitting Loss Calculator 

automatically calculates the total pressure performance of 
each fitting and displays the results in a spreadsheet format, as 
shown below. The report contains more columns than the 
screen can display at one time, so use the horizontal scroll bar 
to bring the other performance information into view. 

2 Click Close to return to the main Fitting Loss Calculator 
window. To name and store your project, click Save. 

Because the velocity pressure drop is the same for both fittings, 
notice that the SD5-9 fitting imposes an additional static pressure 
loss of 0.61 in. wg. through the branch, which reflects the same 
additional loss in total pressure.

Which junction is the “right” choice? That depends. If pressure 
loss in this path is to be minimized, the more efficient (but more 
expensive) SD5-12 fitting may be preferable. Otherwise, the less 
expensive (but less efficient) SD5-9 fitting may be adequate. 

Refer to Chapter 7 for an example of the Fitting Loss Calculator 
report. 
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7 Reports

Each VariTrane Duct Designer application generates one or more 
reports that can be previewed on screen or printed.

Duct Configurator Reports:

Ductulator Report

Fitting Loss Calculator Report

Examples of each type can be found on the following pages.

Entered Values Design Results

Sections Project Summary

Diffusers Sections

VAV Boxes Diffusers

Trane Selection Data VAV Boxes

Bill of Materials Trane Selection Data

Sections Trane Accoustical Data

Fittings Runout Analysis
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Trane optimizes the performance of homes and buildings around the world. A business of
Ingersoll Rand, the leader in creating and sustaining safe, comfortable and energy efficient
environments, Trane offers a broad portfolio of advanced controls and HVAC systems,
comprehensive building services, and parts. For more information, visit www.Trane.com.

Trane  has a policy of continuous product and product data improvement and reserves the right to change design and specifications 
without notice.

We are committed to using environmentally 
conscious print practices that reduce waste.
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